KODAK ESP 5200 Series
All-in-One Printer

Extended User Guide
Table of contents

1 Printer Overview
   Components ........................................................................................................................................................................1
   Control panel ..................................................................................................................................................................2
   Home Center Software ..................................................................................................................................................3
   Configuring printer settings ..........................................................................................................................................3
   Setting your printer as the default printer .......................................................................................................................4

2 Networking Your Printer
   Connecting to a wireless network ...................................................................................................................................5
   Before you connect ..........................................................................................................................................................5
   Connecting to a wireless network using the WiFi Setup Wizard ....................................................................................5
   Using the LCD keyboard ...................................................................................................................................................8
   Setting up an IP address ..................................................................................................................................................8
   Viewing the network configuration ...................................................................................................................................9
   Printing the network configuration ...................................................................................................................................10
   Installing your printer on additional computers on the network ..................................................................................10
   Connecting to another KODAK All-in-One Printer ........................................................................................................10
   Adding a wireless network connection to a USB-connected computer ..........................................................................11
   Changing from USB to a wireless connection ................................................................................................................11

3 Handling Paper
   Paper types ......................................................................................................................................................................13
   Paper sizes ......................................................................................................................................................................13
   Envelope sizes ................................................................................................................................................................14
   Loading paper ................................................................................................................................................................14
   Loading plain paper .......................................................................................................................................................14
   Loading photo paper .....................................................................................................................................................15
   Loading envelopes ........................................................................................................................................................16

4 Printing
   Printing documents ........................................................................................................................................................17
   Printing two-sided documents ......................................................................................................................................17
   Printing pictures ...........................................................................................................................................................18
   Printing from a memory card ........................................................................................................................................18
   Using default settings to print a picture ........................................................................................................................19
   Changing the settings and printing pictures ................................................................................................................19
   Printing tagged pictures ...............................................................................................................................................21
   Zooming and cropping pictures ...................................................................................................................................22
   Printing pictures or documents from a wireless device .................................................................................................23
   Transferring pictures to a computer .............................................................................................................................23
   Transferring pictures to a computer with WINDOWS OS ............................................................................................23
   Transferring pictures to a computer with MAC OS ......................................................................................................23

www.kodak.com/go/aiosupport
5 Copying
Copying a document................................................................................................................................. 24
  Using the default settings to copy a document .................................................................................... 24
  Adjusting the settings and copying a document .................................................................................. 25
  Changing the number of copies of a document .................................................................................... 26
  Enlarging or reducing a document ....................................................................................................... 27
  Darkening or lightening a copy ............................................................................................................ 28
Copying a photograph ............................................................................................................................. 29
  Using the default settings to copy a photograph .................................................................................. 29
  Adjusting the settings and copying a photograph ............................................................................... 30
  Changing the number of copies of a photograph ............................................................................... 31
  Enlarging or reducing a photograph .................................................................................................. 32
  Darkening or lightening a copy of a photograph ................................................................................ 33

6 Scanning
Before you begin scanning .......................................................................................................................... 34
  Changing the scan settings for scanning from the control panel .......................................................... 34
Scanning from the computer ..................................................................................................................... 36
  Scanning multiple pictures simultaneously ......................................................................................... 36
Scanning from the control panel ............................................................................................................. 37

7 Maintaining Your Printer
General care and cleaning ....................................................................................................................... 39
  Cleaning the scanner glass and document backing ............................................................................. 40
Replacing ink cartridges ......................................................................................................................... 41
Replacing the printhead ............................................................................................................................ 44
Updating the software and printer firmware .......................................................................................... 47
  Updating if your printer is connected to a computer with WINDOWS OS ........................................ 47
  Updating if your printer is connected to a computer with MAC OS ................................................ 48
Monitoring and adjusting printer performance ....................................................................................... 49
  Checking ink levels ............................................................................................................................... 49
  Resetting factory defaults .................................................................................................................. 49

8 Troubleshooting
Basic troubleshooting ............................................................................................................................... 50
Getting help on the Web .......................................................................................................................... 51
Status lights ............................................................................................................................................... 52
  Power status light ................................................................................................................................. 52
  Wi-Fi status light ................................................................................................................................. 52

9 Product and Safety Specifications
Specifications and features ....................................................................................................................... 54
  Print performance ................................................................................................................................. 54
  Photo printing features .......................................................................................................................... 54
  Copy document features ...................................................................................................................... 54
Printer Overview

This printer lets you print, copy, and scan pictures and documents. In addition, this printer supports networking, letting you access the printer over a wireless (Wi-Fi) network.

Components

1. Wi-Fi connectivity LED
2. Memory card slot
3. Control panel
4. LCD
5. USB port
6. Power cord connection port
7. Rear-access cleanout area
8. Printer access door
9. Printhead with ink cartridges installed
10. Right paper-edge guide
11. Paper tray
12. Paper tray extender / paper stop
13. Left paper-edge guide
14. Scanner glass
15. Scanner lid
## Control panel

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  LCD</td>
<td>Displays pictures, messages, and menus; lifts for easy viewing</td>
</tr>
<tr>
<td>2  On/Off button</td>
<td>Turns the printer on or off</td>
</tr>
<tr>
<td>3  Home button</td>
<td>Displays the main menu, and toggles between screens</td>
</tr>
<tr>
<td>4  Navigation buttons</td>
<td>Used to navigate menus, scroll through pictures</td>
</tr>
<tr>
<td>5  Zoom buttons</td>
<td>Enlarge or reduce the size of the displayed picture</td>
</tr>
<tr>
<td>6  Start button</td>
<td>Begins copying, scanning, printing, maintenance task, and file transfer</td>
</tr>
<tr>
<td>7  Cancel button</td>
<td>Stops the current operation and returns to the menu; returns to previous item when navigating menus</td>
</tr>
<tr>
<td>8  Rotate button</td>
<td>Changes the orientation of the displayed picture; with the zoom function, changes the orientation of the red box that shows the area of the picture to be printed</td>
</tr>
<tr>
<td>9  OK button</td>
<td>Selects a menu item, accepts a zoom setting, and lets you continue with the current operation</td>
</tr>
<tr>
<td>10  Back button</td>
<td>Displays the previous screen</td>
</tr>
</tbody>
</table>
Home Center Software

KODAK Home Center Software is installed as part of the software installation on your computer. The Home Center icon is added to your desktop and, depending on your configuration, to the Start menu. Use this icon to start Home Center Software.

On a computer with WINDOWS Operating System (OS), you can use Home Center Software to:

• browse, crop, enhance, and edit pictures
• print, scan, and fax
• upgrade your printer with the latest software and firmware
• configure your printer
• order supplies
• access the KODAK Tips and Projects Center

On a computer with MAC OS, you can use Home Center Software to order supplies, configure your printer, set printer scan settings, or check for printer software updates.

Configuring printer settings

To set or change basic printer settings:

1. Press Home.
2. Press ⬇️ to select Printer Settings, then press OK.
3. Press ⬇️ to select one of the following settings:

   • **Date and Time**
     - Press OK, then press ⬇️ to select Year, Month, Day, Hour, or Minute.
     - Press ⬅️ or ⬆️ to change the values; press OK when you are done.
     - **NOTE:** You can also synchronize the printer date and time to your computer using Home Center Software.

   • **Time to Low Power**
     - To conserve energy, the printer will enter a reduced power (sleep) mode automatically after 1 hour. You can adjust the delay time (in 0.5 hour increments) up to 4 hours. Increasing the delay time may result in reduced energy savings.
     - Press ⬆️ to change the time to energy-saving sleep mode (select from 1 to 4 hours in 0.5 hour increments).

   • **Tagged Images Printing** (see Printing tagged pictures, page 21)
     - Press ⬆️ to select Off or On.
• **Language**
  - Press **OK**, press ▼ to select a language, then press **OK**.

• **Country/Region**
  - Press **OK**, press ▼ to select a country or region, then press **OK**.

• **Reset All Settings** (see Resetting factory defaults, page 49)
  NOTE: Resetting factory defaults does not change the date and time, language, country/region, or network settings.

4. Press **Back** to return to the Main Menu.

### Setting your printer as the default printer

If you have more than one printer and your all-in-one printer is not the default printer, you may set it as your default printer.

IMPORTANT: For all operating systems, if you connect your printer with a USB cable and with a wireless connection, your printer may be listed twice. Be sure to select the correct printer. (The name of the printer plus a number indicates a wireless connection; for example, KodakESP5200+1133.)

**For computers with WINDOWS XP OS**
1. Select **Start** > **Control Panel** > **Printers and Faxes**.
2. Right-click your printer, and select **Set as Default Printer**.

**For computers with WINDOWS VISTA OS**
1. Select **Start** > **Control Panel** > **Hardware and Sound** > **Printers**.
2. Right-click your printer, and select **Set as Default Printer**.

**For computers with WINDOWS 7 OS**
1. Select **Start** > **Control Panel** > **Hardware and Sound** > **Devices and Printers**.
2. Right-click your printer, and select **Set as Default Printer**.

**For computers with MAC OS**

When a new printer is installed, it becomes the default printer. If your all-in-one printer is not the default printer:

1. From the dock, open **System Preferences**.
2. In the **Hardware** section, click **Print & Fax**.
3. Select your printer from the drop-down list next to **Default Printer**.
Networking Your Printer

This section explains how to configure or change your network settings.

Connecting to a wireless network

To connect your printer to an 802.11b/g wireless (Wi-Fi) network, refer to the following information.

Before you connect

You need:

- a wireless router.
- to determine whether your wireless router supports Wi-Fi Protected Setup (WPS).

NOTE: If you have specific questions about your router, see your router manufacturer’s documentation for more information.

Connecting to a wireless network using the WiFi Setup Wizard

You can use the WiFi Setup Wizard on the printer to connect to your wireless network. Use the procedure that is appropriate for your network setup.

Connecting to a non-WPS wireless router

To connect your printer to your wireless network, you need to know the network name, also called the Service Set Identifier (SSID). You can obtain your network name from the wireless router.

If your network has security enabled, you also need to know the password (passphrase or security string).

Record your network information in the spaces below, using the correct uppercase and lowercase letters.

Network Name (SSID):_____________________________________________________

Security String: __________________________________________________________

1. Press Home.
2. Press ➔ to select Network Settings, then press OK.
3. With WiFi Setup Wizard selected, press OK.

   NOTE: The Wi-Fi radio turns on when you select Wi-Fi Setup Wizard.
Networking Your Printer

The Wi-Fi connectivity LED blinks as the printer searches for available wireless networks within range, then displays the list in order of signal strength. For example:

If there are additional networks than can be shown on the LCD, press 👈 to view them. If you don’t see your network in the list, or if you want to change your network, select Rescan for Wireless Networks, then press OK.

4. If the name of your network is:

<table>
<thead>
<tr>
<th>Listed</th>
<th>Not listed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press 👈 to select your network, then press OK.</td>
<td>Make sure your wireless router is turned on and within range. If your wireless router does not broadcast its SSID (network name):</td>
</tr>
<tr>
<td></td>
<td>1. Press 👈 to select Unlisted Network, then press OK.</td>
</tr>
<tr>
<td></td>
<td>2. Use the LCD keyboard (see Using the LCD keyboard, page 8) to enter your network name.</td>
</tr>
<tr>
<td></td>
<td>3. Select WEP or WPA/WPA2 as required for your network’s security setup, then press OK.</td>
</tr>
</tbody>
</table>

5. If your network has security enabled, use the LCD keyboard (see Using the LCD keyboard, page 8) to enter your security string.

6. When the confirmation message appears, press OK.

   If the printer is successfully connected, the Wi-Fi connectivity LED stops blinking and remains lit.

7. If you haven’t yet installed the KODAK All-in-One Printer Software, go to www.kodak.com/go/esp5250downloads or www.kodak.com/go/esp5210downloads, and follow the on-screen instructions to install the software.

   The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP5200+1133).
Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), you can use WPS Connect. WPS lets you configure your printer for a wireless network by pressing buttons or entering a PIN.

To connect to a network using WPS:

1. Press **Home**.
2. Press **▼** to select **Network Settings**, then press **OK**.
3. With **WiFi Setup Wizard** selected, press **OK**.
   NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup Wizard.
4. With **WPS Connect** selected, press **OK**.
5. Select one of two methods of connecting:
   IMPORTANT: Before you press **OK** on the printer, make sure you know where the router’s push button is, or where to enter the generated PIN. If necessary, consult your Internet service provider or router device manufacturer’s documentation for more information.
6. When the confirmation message appears, press **OK**.
   If the printer is successfully connected, the Wi-Fi LED stops blinking and remains lit.
7. If you haven’t yet installed the KODAK All-in-One Printer Software, go to www.kodak.com/go/esp5250downloads or www.kodak.com/go/esp5210downloads, and follow the on-screen instructions to install the software.
   The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP5200+1133).

<table>
<thead>
<tr>
<th>Pressing a button</th>
<th>Entering a PIN</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong> You will have two minutes to press or select the WPS button. It may be a button on the device or a virtual button in the device’s software.</td>
<td>a. Press <strong>▼</strong> to select <strong>Generate WPS PIN</strong>, then press <strong>OK</strong>.</td>
</tr>
<tr>
<td>a. With <strong>Push Button Configuration</strong> selected, press <strong>OK</strong>.</td>
<td>b. In your wireless router’s software, locate the PIN screen.</td>
</tr>
<tr>
<td>b. Press or select the WPS button for your wireless router.</td>
<td>c. Enter the PIN you received on the LCD into the PIN screen.</td>
</tr>
</tbody>
</table>
Networking Your Printer

Using the LCD keyboard

When you need to enter letters or numbers, a keyboard appears on the LCD. There are two types of keyboards, depending on which printer model you have.

- To change from uppercase to lowercase, select abc/123, then press OK.
- To change from lowercase to uppercase, select ABC/123, then press OK.
- To enter punctuation or symbols, select !@#, then press OK.

Use the arrow keys to select the letters, numbers, and symbols, then press OK.

On the control panel (both types of keyboards), press ▲, ▼, ◀ or ▶ to select the letters and numbers, using the correct uppercase and lowercase letters. Press OK after each character. When you are done, select DONE, then press OK.

Setting up an IP address

IMPORTANT: You should only need to set up an IP address for your printer if you are having a problem with connecting. Typically, it is not necessary to set up an IP address. This procedure is for advanced users who know how to obtain the IP address for the printer.

All IP address entries have the following format: 000.000.000.000. Within each three-digit grouping, the number must be right-justified. If an address or subnet mask has only one or two characters between the periods, include one or two leading zeros in front of that number. For example:

<table>
<thead>
<tr>
<th>The address as it may appear in your documentation</th>
<th>How to enter the address in the printer menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>149.89.138.149</td>
<td>149.089.138.149</td>
</tr>
<tr>
<td>149.2.40.149</td>
<td>149.002.040.149</td>
</tr>
</tbody>
</table>
To set up your IP address on the printer:

1. Press **Home**.
2. Press ▼ to select **Network Settings**, then press **OK**.
3. Press ▼ to select **Advanced IP Address Setup**, then press **OK**.
4. Press **OK** again to continue.
5. Select one of the following, then press **OK**:
   - **Dynamic (DHCP)**
   - **Automatic (Private)**
   - **Manual (Static)**
6. If you selected **Manual (Static)**, you are prompted to enter an IP address, a Subnet Mask, a Gateway Address, and a DNS Server address. Press **OK** after each entry. Use the navigation buttons to enter each digit of the numbers. Consult your Internet service provider or network administrator for more information.

**Viewing the network configuration**

To view the network configuration and verify that you are connected to your wireless network:

1. Press **Home**.
2. Press ▼ to select **Network Settings**, then press **OK**.
3. Press ▼ to select **View Network Configuration**, then press **OK**.
   - The wireless or Ethernet network settings appear on the LCD, including:
     - Printer Hostname
     - Connection
     - Speed
     - IP Address
     - IP Address Type
     - Network Subnet
     - Connected Network SSID
     - Security
     - Authentication
     - Channel
     - Region
     - Radio (on/off)
     - MAC Address
   - If the printer is connected to your network, you will see the network name and the word CONNECTED.
4. To scroll through the information, press ▼.
5. When you are done, press **OK**.
Networking Your Printer

Printing the network configuration

To print the current network configuration:

1. Load plain paper into the printer. (See Loading plain paper, page 14.)
2. Press Home.
3. Press ▼ to select Network Settings, then press OK.
4. Press ▼ to select Print Network Configuration, then press OK.

Installing your printer on additional computers on the network

To add your printer to another computer(s) on your network, install the KODAK All-in-One Printer Software on each computer. Go to www.kodak.com/go/esp5250downloads or www.kodak.com/go/esp5210downloads, and follow the on-screen instructions.

Connecting to another KODAK All-in-One Printer

If you are connecting to a newer model printer (for example, you have an ESP 7 printer and now you are adding an ESP 5250 printer), you must install the software for the newer model.

If you are connecting to another ESP 5250 printer or to a previous model:

On a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.
   • If your wireless all-in-one printer (example: KodakESP5200+1133) is not listed:
     a. Select No, my printer is not listed, then click Next.
     b. From the drop-down list, select your printer.
     c. Select Network - Wireless/WiFi, then click Next.
        When your printer is detected, driver installation begins.
   • If your wireless all-in-one printer (example: KodakESP5200+1133) is listed:
     a. Highlight the all-in-one printer that is connected to your network.
     b. Select Yes, my printer is listed, then click Next.
        When your printer is detected, driver installation begins.
2. When driver installation is complete, click Done.

On a computer with MAC OS:

1. Select Apple > System Preferences.
2. Under Hardware, select Print & Fax.
3. In the Print & Fax dialog box, click +.
4. Select your printer from the list, then click Add.
Adding a wireless network connection to a USB-connected computer

You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection

To change the printer connection type from USB to a wireless (Wi-Fi) network:

If your printer is connected to a computer with WINDOWS OS:

1. Unplug the USB cable from your printer and computer.
2. On the printer control panel, press Home.
3. Press ▼ to select Network Settings, then press OK.
4. Press ▼ to select View Network Configuration, press OK, then confirm you have a non-zero IP address.
5. If you have not already done so, connect your printer to your wireless network. See Connecting to a wireless network, page 5.
6. On your computer, disable any firewall you have installed until you have successfully completed the installation. For more information on firewalls, go to www.kodak.com/go/inkjetnetworking.
7. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.
   • If your wireless all-in-one printer (example: KodakESP5200+1133) is not listed:
     a. Select No, my printer is not listed, then click Next.
     b. Select your printer from the list.
     c. Select Network - Wireless/WiFi, then click Next.
     When your printer is detected, driver installation begins.
   • If your wireless all-in-one printer (example: KodakESP5200+1133) is listed:
     a. Highlight the all-in-one printer that is connected to your network.
     b. Select Yes, my printer is listed, then click Next.
     When your printer is detected, driver installation begins.
8. When driver installation is complete, click Done.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP5200+1133).
If your printer is connected to a computer with MAC OS:

1. Unplug the USB cable from your printer and computer.
2. On the printer control panel, press Home.
3. Press \( \uparrow \) to select Network Settings, then press OK.
4. Press \( \uparrow \) to select View Network Configuration, press OK, then confirm you have an IP address.
5. Select Apple > System Preferences.
6. Under Hardware, select Print & Fax.
7. In the Print & Fax dialog box, click +.
8. Select your printer from the list, then click Add.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP5200+1133).
Handling Paper

For the best photo printing results, use KODAK Photo Papers, which are optimized to work with KODAK All-in-One Printers.

For the best document printing results, use KODAK Document Papers or a paper with the COLORLOK Technology logo on the package. Use only paper that is designed for inkjet printers.

When handling paper:

- Hold the paper by the edges; avoid placing your fingerprints on it.
- Do not touch the glossy side of photo paper.
- Store paper flat, away from direct sunlight and heat.

Paper types

You can use:

- Plain paper — 20 to 24 lb / 75 to 90 gsm
- Photo paper — 6.5 to 12 mils (up to 290 gsm)
- Card stock — 110 lb / 200 gsm, max
- Envelopes — 20 to 24 lb / 75 to 90 gsm
- Transparencies — inkjet variety with white stripe
- Labels — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets
- Iron-on transfers — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets

Paper sizes

The printer accepts the following paper sizes:

- 4 x 6 in. / 10 x 15 cm
- 4 x 7 in. / 10 x 18 cm
- 4 x 12 in. / 10 x 31 cm
- 5 x 7 in. / 13 x 18 cm
- 7.3 x 8.5 in. / 18 x 22 cm
- 7.3 x 10.5 in. / 18 x 22 cm
- 8 x 10 in. / 20 x 25 cm
- 8.5 x 11 in. / 22 x 28 cm
- 8.5 x 14 in. / 22 x 36 cm
- A4 (8.3 x 11.7 in. / 21 x 30 cm)
- A5 (5.8 x 8.3 in. / 15 x 21 cm)
- A6 (4.1 x 5.8 in. / 11 x 15 cm)
- B5 (6.9 x 9.8 in. / 18 x 25 cm)

NOTE: Do not load paper smaller than 4 x 6 in. / 10 x 15 cm.
Envelope sizes

The printer accepts the following envelope sizes:

- C5 (6.7 x 9 in. / 16 x 23 cm)
- C6 (4.5 x 6.4 in. / 11 x 16 cm)
- DL (4.3 x 8.7 in. / 11 x 22 cm)
- US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)
- US #9 (3.9 x 8.9 in. / 10 x 23 cm)
- US #10 (4.1 x 9.5 in. / 11 x 24 cm)

IMPORTANT: Do not load envelopes with cutout or clear windows.

Loading paper

Loading plain paper

The paper tray capacity is 100 sheets of plain paper.

To load plain paper:

1. Open the paper tray.

2. Pull out the paper tray extender until it is fully extended.

3. Lift the paper stop.

4. Move the left paper-edge guide to the far left.
5. Fan and stack the paper, then insert it into the tray.
6. Move the paper forward until it stops.
7. Move the left paper-edge guide until it touches the paper.

Loading photo paper

The paper tray capacity is 20 sheets of photo paper.

To load photo paper:

1. Remove any plain paper from the tray.
2. Fan and stack the photo paper, then insert the paper (short side first) into the tray with the **logo side facing up** and the glossy side down.
   
   **IMPORTANT:** *If the photo paper is loaded the wrong way, the ink on your pictures will be wet and the image quality will be affected.*

3. Move the paper forward until it stops.
4. Move the left paper-edge guide until it touches the paper.
Loading envelopes

The paper tray capacity is 20 envelopes.

IMPORTANT: Do not load envelopes with cutout or clear windows.

To load envelopes:

1. Remove all paper from the tray.
2. Make sure the left paper-edge guide is to the far left.
3. Insert the envelope(s) into the tray with the flap up and against the right side of the tray.
4. Move the envelopes forward until they stop.
5. Move the left paper-edge guide until it touches the envelope(s).
4 Printing

Print documents and lab-quality pictures on your printer.

Printing documents

To print a document:
1. Open the document on your computer.
2. Select File > Print.
3. In the Print dialog box, select your KODAK Printer.
4. Choose the pages to print, number of copies, etc, then click OK (on a computer with WINDOWS OS) or Print (on a computer with MAC OS).

Printing two-sided documents

You can print two-sided documents on any size paper that the printer accepts when you rotate the paper manually. (See Paper sizes, page 13.)

IMPORTANT: Two-sided printing will not work on bar-coded photo paper (the bar code is on the back side). Two-sided printing can only be done on media that can absorb ink on both sides, such as plain paper or two-sided photo paper.

Printing two-side documents from a computer with WINDOWS OS

To print two-sided documents from a computer with WINDOWS OS:
1. Load paper into the paper tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that KODAK ESP 5200 Series AiO (or for a wireless connection, KodakESP5200+XXXX, where XXXX is a number) is selected, then click Properties.
4. Select the Layout tab.
5. In the Two-sided printing field, select Manual (Instructions provided), then click OK.
6. Click OK.
7. When a message appears on your computer and printer LCD, remove the printed pages from the output tray.
8. Rotate the printed pages 180 degrees, and place them into the paper tray (printed side up).

Printing two-side documents from a computer with MAC OS

To print two-sided documents from a computer with MAC OS:
1. Load paper into the paper tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that Eastman Kodak Company ESP 5200 Series AiO (or for a wireless connection, KodakESP5200+XXXX, where XXXX is a number) is selected.
4. In the **Copies & Pages** drop-down list, select **Paper Handling**.
5. In the **Pages to Print** drop-down list, select **Odd Only**.
6. In the **Page Order** drop-down list, select **Reverse**.
7. Click **Print**.
8. When the odd pages have finished printing, remove them from the output tray.
9. Rotate the printed pages 180 degrees, and place them into the paper tray (printed side up).
10. Select **File > Print**.
11. In the **Copies & Pages** drop-down list, select **Paper Handling**.
12. In the **Pages to Print** drop-down list, select **Even Only**.
13. In the **Page Order** drop-down list, select **Normal**.
14. Click **Print**.

### Printing pictures

You can print pictures with your all-in-one printer from a memory card inserted into a memory card slot, or you can print pictures using Home Center Software from your computer with WINDOWS OS. Home Center Software lets you edit and enhance your pictures quickly. Open Home Center Software, select **Print Pictures**, then follow the on-screen instructions.

On a computer with either MAC OS or WINDOWS OS, you can print pictures from KODAK EASYSHARE Software or any picture-editing or photo-management software.

### Printing from a memory card

Your printer accepts the following memory cards:

- SD Card
- SDHC Card
- MMC Card
- MEMORY STICK
- Variations of the memory cards listed above that require an adapter (for example, MEMORY STICK Duo, miniSD, and microSD)

**IMPORTANT:** If you use a memory card with an adapter, make sure you insert and remove the adapter and the memory card as a unit; do not remove the memory card while leaving the adapter in the printer.
Using default settings to print a picture

To print a picture from a memory card using the factory default settings:

1. Load photo paper with the logo side facing up (see Loading photo paper, page 15), and move the left paper-edge guide until it touches the paper.
2. Insert the memory card into the memory card slot.
3. Press or to select the picture you want to print.
4. Press Start to begin printing.

The printer prints one 4 x 6 in. / 10 x 15 cm picture.

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the printer while printing.

Changing the settings and printing pictures

You can change the print photos options for an individual picture or group of pictures, or you can change the settings and save them as the default.

To print a picture or pictures using settings other than the default settings:

1. Load photo paper with the logo side facing up (see Loading photo paper, page 15), and move the left paper-edge guide until it touches the paper.
2. Insert the memory card into the memory card slot.
3. Press or to select the picture you want to print, then press OK.
4. Repeat step 3 for each picture you want to print.
5. Press ▼ to select **View and Print Photos**, then press **OK**.
6. Press ▼ to select an option, then press ◀ or ► to change the setting.

<table>
<thead>
<tr>
<th>Print Photos Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Photos</td>
<td>--</td>
<td>Scroll through the pictures on the memory card.</td>
</tr>
<tr>
<td>Transfer All to PC</td>
<td>--</td>
<td>To transfer all the pictures on the memory card to your computer, press <strong>OK</strong> then <strong>Start</strong>. (Your printer and computer must be connected with a USB cable.)</td>
</tr>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
</tbody>
</table>
| Print Size               | 2 x 3
3.5 x 5
4 x 6 (default)
4 x 7
5 x 7
4 x 12
8 x 10
8.5 x 11 or A4 | If the selected copy size is smaller than the paper in the paper tray, the printer automatically arranges the pictures to best fit the paper size. |
| Plain Paper Quality      | Normal (default) | Good quality output; prints faster than Best.                               |
|                          | Best           | The highest quality.                                                        |
|                          | Draft          | The fastest print speed.                                                     |
| Photo Paper Quality      | Automatic (default) | The printer detects photo paper in the paper tray and sets Best quality automatically. |
| Color                    | Color (default) | Prints full color.                                                          |
|                          | Black & White  | Prints black and white (gray scale).                                        |
| Scene Balance            | On (default) Off | Adjusts the image brightness to correct for underexposure and reduces the variation in contrast in different areas of the picture. |
| Add Date to Prints       | No (default) Yes | Prints the date of the picture(s) (the date the picture was taken or last edited) in a corner of the print. |
7. When you have finished changing settings, press Start to begin printing.

IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, do not remove it from the printer while printing.

### Printing tagged pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for printing. This creates a tag that is recognized by the printer. If you choose to print tagged pictures, they will be printed according to the default settings on your printer (unless otherwise specified by the tag from the camera).

**NOTE:** Refer to your camera user guide to determine whether your camera supports tagged (also “marked” or “DPOF”) functionality.

To print tagged pictures:

1. Load photo paper with the logo side facing up (see Loading photo paper, page 15), and move the left paper-edge guide until it touches the paper.
2. Insert the memory card into the memory card slot.
3. When the “Print tagged images?” message appears, press Start.

<table>
<thead>
<tr>
<th>Print Photos Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new default, press OK. With Yes selected, press OK.</td>
</tr>
</tbody>
</table>
Zooming and cropping pictures

Use the zoom buttons to select a portion of your picture for printing.

![Zoom buttons](image)

To zoom and crop a picture:

1. Load photo paper with the logo side facing up (see Loading photo paper, page 15), and move the left paper-edge guide until it touches the paper.
2. Insert the memory card into the memory card slot.

3. Press ◀ or ▶ to select the picture you want to crop, then press OK.
4. Press Zoom + to enlarge the picture on the LCD. A red box shows the area that will be printed.
   
   NOTE: You can press Zoom + repeatedly to enlarge the picture in increments of 0.25 up to a magnification of 5X. Press Zoom – to decrease the magnification in increments of 0.25 back down to 1X.

5. Use the navigation buttons to move the picture on the LCD up, down, left, or right. Only the part of the picture in the red box will print. The crop window matches the aspect ratio of the selected output print size.
6. After you have pressed the zoom button(s), press Rotate if you want to rotate the red box in 90 degree increments. This will determine the content that is printed.
   
   NOTE: Zooming and cropping does not change the saved picture on the memory card.
7. When you are satisfied with the picture, press OK. The picture appears in the original view with a red box around the portion of the picture that will print.
8. Press Start to begin printing.
Printing pictures or documents from a wireless device

Wirelessly print pictures from an iPhone, iPod touch, or iPad* at the touch of a button. Download the KODAK Pic Flick App from the App Store, or go to www.kodak.com/go/picflick for more information.

* Compatible with iPhone (with MAC OS 2.2 or later), iPod touch (2nd generation), and iPad.

Transferring pictures to a computer

You can transfer .jpg, .mov, and .wav files from a memory card in the printer to your computer. To transfer these files, the printer must be connected to your computer with a USB cable and Home Center Software must be installed on your computer.

NOTE: If you have large video files or a large number of pictures (400 or more), we recommend that you transfer them using a memory card reader attached directly to your computer.

Transferring pictures to a computer with WINDOWS OS

1. Insert the memory card into the memory card slot on the printer.
2. Press Back.
3. Press \( \uparrow \) to select View and Print Photos, then press OK.
4. Press \( \uparrow \) to select Transfer All to PC, then press OK.
5. Press Start.
6. If your computer is connected to a wireless network and with a USB cable, select the USB-connected printer (no number after the printer name).
7. Follow the on-screen instructions on your computer.

Transferring pictures to a computer with MAC OS

1. Insert the memory card into the memory card slot on the printer.
2. Press Back.
3. Press \( \uparrow \) to select View and Print Photos, then press OK.
4. Press \( \uparrow \) to select Transfer All to PC, then press OK.
5. Press Start.
6. If your computer is connected to a wireless network and with a USB cable, select the USB-connected printer (no number after the printer name).
7. Use iPhoto or Image Capture on your computer to complete the transfer.
Copying

You can copy documents and pictures with your all-in-one printer. The printer produces high-quality color or black-and-white copies on a variety of paper types (see Paper types, page 13).

Copying a document

You can copy a document using the default settings, or you can adjust the quantity, size, quality, and brightness of your copies.

Using the default settings to copy a document

The default settings are either the factory default settings (see Resetting factory defaults, page 49), or defaults that you have set on the printer (see Save as Defaults at the bottom of the table under Adjusting the settings and copying a document, page 25).

To copy a document using the current default settings:

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.
2. Close the lid.
4. Press Start to begin copying.
Adjusting the settings and copying a document

To copy a document using settings other than the default settings:

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.

2. Close the lid.
4. Make sure Copy Document is selected, then press OK.
5. Press † to select an option, then press ‡ or § to change the setting.

<table>
<thead>
<tr>
<th>Copy Document Option</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Color</td>
<td>Color (default)</td>
<td>Prints full color.</td>
</tr>
<tr>
<td></td>
<td>Black &amp; White</td>
<td>Prints black and white (gray scale).</td>
</tr>
<tr>
<td>Copy Size</td>
<td>Same Size (default)</td>
<td>The copy is the same size as the original.</td>
</tr>
<tr>
<td></td>
<td>Fit to Page</td>
<td>The printer detects the size of the original on the scanner glass and the size of the paper in the paper tray, and automatically reduces or enlarges the original so that the copy fits on the paper.</td>
</tr>
<tr>
<td></td>
<td>20% to 500%</td>
<td>Reduces up to 20% or enlarges up to 500% of the original size.</td>
</tr>
</tbody>
</table>
Changing the number of copies of a document

To change the number of copies:

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.

2. Close the lid.

### Copy Document Option

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper Quality</td>
<td>Good quality output; prints faster than Best.</td>
</tr>
<tr>
<td>Best</td>
<td>The highest quality, but the slowest print speed; eliminates the banding effect that sometimes occurs when printing Draft or Normal.</td>
</tr>
<tr>
<td>Draft</td>
<td>The fastest print speed, but the lowest quality.</td>
</tr>
<tr>
<td>Photo Paper Quality</td>
<td>The printer detects photo paper in the paper tray and sets Best quality automatically.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Lightens or darkens the copy. Normal is no change from the original; -3 is the darkest; +3 is the lightest.</td>
</tr>
</tbody>
</table>

### Save as Defaults

- No / Yes

To save the settings as the new default, press OK. With Yes selected, press OK.

6. Press **Start** to begin copying.
3. Press **Home.**
4. Make sure **Copy Document** is selected, then press ‹ or › to select a number.
5. Press **Start** to begin copying.

**Enlarging or reducing a document**

To enlarge or reduce the size of the copy:

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.
2. Close the lid.
3. Press **Home.**
4. Make sure **Copy Document** is selected, then press **OK**.
5. Press ‹ to select **Copy Size.**
6. Press ‹ or › to select an enlargement or reduction.
7. Press **Start** to begin copying.
Darkening or lightening a copy

To darken or lighten the copy:

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.

2. Close the lid.

3. Press **Home**.

4. With **Copy Document** selected, press **OK**.

5. Press **▼** to select **Brightness**.

6. Press **◄** to select a number below zero for a darker copy, or press **►** to select a number above zero for a lighter copy.

7. Press **Start** to begin copying.
Copying a photograph

You can copy a photograph using the default settings, or you can adjust the quantity, size, quality, and brightness of your copies.

Using the default settings to copy a photograph

The default settings are either the factory default settings (see Resetting factory defaults, page 49), or defaults that you have set on the printer (see Save as Defaults at the bottom of the table under Adjusting the settings and copying a photograph, page 30).

To copy a photograph using the current default settings:

1. Lift the scanner lid, and place the photograph face down in the right-front corner of the scanner glass.
2. Close the lid.
4. Press ▼ to select Copy Photo.
5. Press Start to begin copying.
Adjusting the settings and copying a photograph

To copy a photograph using settings other than the default settings:

1. Lift the scanner lid, and place the photograph face down in the right-front corner of the scanner glass.

2. Close the lid.
4. Press ▼ to select Copy Photo, then press OK.
5. Press ▼ to select an option, then press ▼ or ▲ to change the setting.

<table>
<thead>
<tr>
<th>Copy Photo Option</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Color</td>
<td>Color (default)</td>
<td>Prints full color.</td>
</tr>
<tr>
<td></td>
<td>Black &amp; White</td>
<td>Prints black and white (gray scale).</td>
</tr>
<tr>
<td>Copy Size</td>
<td>2 x 3</td>
<td>The printer enlarges or reduces the original to make it the copy size you select.</td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td>If the selected copy size is smaller than the paper in the paper tray, the printer automatically arranges the pictures to best fit the paper size.</td>
</tr>
<tr>
<td></td>
<td>4 x 6 (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 12</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 or A4</td>
<td></td>
</tr>
</tbody>
</table>
6. Press **Start** to begin copying.

### Changing the number of copies of a photograph

To change the number of copies:

1. Lift the scanner lid, and place the photograph face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press **Home**.
4. Press \( \downarrow \) to select **Copy Photo**, then press **OK**.
5. Make sure **Quantity** is selected.
6. Press \( \leftarrow \) or \( \rightarrow \) to select a number.
7. Press **Start** to begin copying.

**Enlarging or reducing a photograph**

To enlarge or reduce the size of the copy:

1. Lift the scanner lid, and place the photograph face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press **Home**.
4. Press \( \downarrow \) to select **Copy Photo**, then press **OK**.
5. Press \( \downarrow \) to select **Copy Size**.
6. Press \( \leftarrow \) or \( \rightarrow \) to select the copy size.
7. Press **Start** to begin copying.
Darkening or lightening a copy of a photograph

To darken or lighten the copy:

1. Lift the scanner lid, and place the photograph face down in the right-front corner of the scanner glass.

2. Close the lid.
4. Press \(\downarrow\) to select Copy Photo, then press OK.
5. Press \(\downarrow\) to select Brightness.
6. Press \(\uparrow\) to select a number below zero for a darker copy, or press \(\downarrow\) to select a number above zero for a lighter copy.
7. Press Start to begin copying.
Scanning

Scanning digitizes documents and pictures, and sends the digital files to your computer.

When you scan, the digital file can:

- Open in Home Center Software (when connected to a computer with WINDOWS OS)
- Open in a third-party scanner software
- Be saved in a format and location that you determine (see Changing the scan settings for scanning from the control panel, page 34)

Scanning from a software program on the computer (such as Home Center Software) gives you more options, but you can also scan from the printer control panel.

Before you begin scanning

Make sure that the printer is connected to a computer using a USB cable or wireless network (see Chapter 2, Networking Your Printer).

Changing the scan settings for scanning from the control panel

Make sure that Home Center Software is installed on the computer. (If not, go to www.kodak.com/go/esp5250downloads or www.kodak.com/go/esp5210downloads, and follow the on-screen instructions to install the KODAK All-in-One Printer Software.) Then change the scan settings in Home Center Software. The printer uses these settings when you scan from the printer control panel.

1. Open Home Center Software.
2. Select Tools and Documentation (when connected to a computer with WINDOWS OS) or Tools (when connected to a computer with MAC OS).
3. Select Printer Scan Settings.
4. Adjust settings for scanning documents and pictures as described below.

To adjust settings for scanning documents, select the Document tab, then select an option for each setting:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan As</td>
<td>Black and white&lt;br&gt;Color&lt;br&gt;Grayscale</td>
</tr>
<tr>
<td>File format</td>
<td>.pdf&lt;br&gt;.rtf (available only when connected to a computer with WINDOWS OS)&lt;br&gt;.tif&lt;br&gt;.jpg&lt;br&gt;.bmp (available only when connected to a computer with MAC OS)</td>
</tr>
</tbody>
</table>
To adjust settings for scanning pictures, select the **Picture** tab, then select an option for each setting:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution (dpi)</td>
<td>75, 150, 200, 300</td>
</tr>
<tr>
<td>File Save</td>
<td>Prompt for File Name and Location</td>
</tr>
<tr>
<td></td>
<td>Automatically Save - specify:</td>
</tr>
<tr>
<td></td>
<td>• Base name; by default, scanned files are names “scan1&quot;, “scan2”, and so on.</td>
</tr>
<tr>
<td></td>
<td>• Location (folder) where the scanned files will be saved</td>
</tr>
<tr>
<td>Scan As</td>
<td>Black and white, Color, Grayscale</td>
</tr>
<tr>
<td>File format</td>
<td>.jpg, .bmp, .tif</td>
</tr>
<tr>
<td>Resolution (dpi)</td>
<td>75, 150, 300, 600</td>
</tr>
<tr>
<td>Quality</td>
<td>When connected to a computer with WINDOWS OS:</td>
</tr>
<tr>
<td></td>
<td>• Best for E-mail</td>
</tr>
<tr>
<td></td>
<td>• Normal</td>
</tr>
<tr>
<td></td>
<td>• High</td>
</tr>
<tr>
<td></td>
<td>• Maximum</td>
</tr>
<tr>
<td>Quality</td>
<td>When connected to a computer with MAC OS, a slider bar with:</td>
</tr>
<tr>
<td></td>
<td>• Least</td>
</tr>
<tr>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td>• Best</td>
</tr>
</tbody>
</table>
Before saving a scanned file, you can preview it in Home Center Software version 6.0, crop and sharpen the image, and adjust color, if desired. On a computer with WINDOWS OS, see the Home Center Software Help (?) icon for instructions.

### Scanning from the computer

To scan a document or a picture on a computer:

1. Lift the scanner lid, and place the document or picture face down on the glass.
2. Close the scanner lid.
3. Open Home Center Software.
   - On a computer with WINDOWS OS, select **Scan Documents and Pictures**, then follow the on-screen instructions.
   - On a computer with MAC OS and Home Center Software version 6.0, select the **Tools** tab, click **Scan Application**, then follow the on-screen instructions.

### Scanning multiple pictures simultaneously

Using Home Center Software, you can scan multiple pictures simultaneously and save them as separate files.

When scanning multiple pictures, leave space between the pictures so that the printer can detect the separate pictures. Any pictures that overlap are interpreted as a single picture.
Scanning multiple pictures when connected to a computer with WINDOWS OS

To scan multiple pictures simultaneously, and save them as separate files:

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space between the pictures.
2. Close the lid.
3. Open Home Center Software, then select Tools and Documentation.
4. Click Printer Scan Settings, then select the Picture tab.
5. Select Automatically Detect Pictures, if it is not selected, then click OK.
6. Click the Home icon in the top right corner, then select Scan Documents and Pictures.
7. Make sure that Picture is selected and Collage - Combine all pictures is cleared, then follow the on-screen instructions.

NOTE: Click the Help icon for additional instructions.

Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files:

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space between the pictures.
2. Close the lid.
3. Open Home Center Software version 6.0, then select your printer.
4. Select the Tools tab.
5. Click Scan Application.
6. Select Color Picture or Black and White Picture.
7. Select Automatically detect multiple pictures, if it is not selected.
8. Click Preview or Scan All, then follow the on-screen instructions.

NOTE: Click the Help icon for additional instructions.

Scanning from the control panel

To scan a document or a picture from the control panel:

1. Load the original.
2. Press Home.
3. Press \(\uparrow\) to select Scan, then press OK.
   - The Scan Options menu appears on the LCD.
4. Press ◀ to select an option, then press ◄ or ► to change the setting.

<table>
<thead>
<tr>
<th>Scan Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan To</td>
<td>USB-connected computer (default)</td>
<td>The scanned file is sent to the USB-connected computer.</td>
</tr>
<tr>
<td>Name of computer (only if a computer is connected by wireless network)</td>
<td></td>
<td>The scanned file is sent to the computer on the wireless or Ethernet network.</td>
</tr>
<tr>
<td>Scan What</td>
<td>Document (default)</td>
<td>Sets the scan settings for scanning a document (see Changing the scan settings for scanning from the control panel, page 34).</td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td>Sets the scan settings for scanning a photograph (see Changing the scan settings for scanning from the control panel, page 34).</td>
</tr>
<tr>
<td>Destination</td>
<td>File (default)</td>
<td>Sends the scanned file in the format and to the location on your computer that you designate (see Changing the scan settings for scanning from the control panel, page 34).</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td>Sends the scanned file to Home Center Software.</td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new default, press OK. With Yes selected, press OK.</td>
</tr>
</tbody>
</table>

5. Press Start to make a scan.
The scanned file appears at the destination you specified.
Maintaining Your Printer

Your printer requires little maintenance. However, Kodak recommends cleaning the scanner glass and lid regularly to remove dust and fingerprints, which affect the quality and accuracy of scanning.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. If you use a power strip, don’t turn off the power strip. (The printer does not necessarily have to be turned on, but should be plugged in.)

Keep the printhead and ink cartridges in the printer at all times to help prevent damage to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, go to the Electronics Industry Alliance at www.eia.org or go to www.kodak.com/go/recycle.

General care and cleaning

⚠️ CAUTION:
Always disconnect the power to the printer before cleaning it. Do not use harsh or abrasive cleaners on any part of the printer.

- To clean the printer, wipe the outside with a clean, dry cloth.
- Keep the surrounding area vacuumed and litter-free.
- Protect the printer from tobacco smoke, dust, and liquid spills.
- Do not place objects on the printer.
- Keep the printer supplies away from direct sunlight and out of high-temperature environments.
- Do not allow chemicals to come into contact with the printer.
Cleaning the scanner glass and document backing

The scanner glass can get smudged and minor debris can accumulate on the white document backing under the scanner lid. Periodically clean the scanner glass and document backing.

⚠️ **CAUTION:**

  Do not use harsh or abrasive cleaners on any part of the printer.
  Do not spray liquid directly on the glass.
  Do not use paper-based wipes on the document backing as they can scratch it.

To clean the scanner glass and document backing under the scanner lid:

1. Turn off the printer and unplug it from the power outlet.
2. Lift the scanner lid.

3. Wipe the glass with a soft cloth or sponge, slightly moistened with a nonabrasive glass cleaner.
4. Dry the glass with a lint-free cloth.
5. Gently clean the document backing with a soft cloth or sponge, slightly moistened with mild soap and warm water.
6. Dry the document backing with a chamois or lint-free cloth.

   **NOTE:** If the document backing needs further cleaning, use isopropyl (rubbing) alcohol on a soft cloth, then wipe thoroughly with a cloth moistened with water to remove any residual alcohol.

7. When you finish cleaning, plug in the printer and press the on/off button to power on the printer.
Replacing ink cartridges

Your printer uses both black and color ink cartridges. You can check the approximate ink levels on the LCD (see Checking ink levels, page 49) or in Home Center Software. When an ink cartridge is out of ink, the printer LCD displays a message stating that the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.

To replace an ink cartridge:

1. Make sure your printer is on.
2. Lift the printer access door, and wait for the carriage to move to a position where you can access it.

The ink cartridges are located in the printhead.
3. Pinch the tab on the ink cartridge and lift it out of the printhead.

![Image of ink cartridge being lifted out of printhead]

4. Remove the new ink cartridge from its bag.

![Image of ink cartridge being removed from bag]

**IMPORTANT:** To prevent the printhead from drying out, insert the ink cartridge into the printhead immediately.

5. Remove the protective cap from the cartridge.

![Image of protective cap being removed from ink cartridge]
6. Insert the ink cartridge into the printhead.

7. Press down on the ink cartridge tab until you hear a click.

8. Close the printer access door.
Replacing the printhead

IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace the printhead only if you receive a new printhead from Kodak.

To replace the printhead:
1. Make sure your printer is on.
2. Lift the printer access door, and wait for the carriage to move to the access position.
3. Remove both ink cartridges and set them aside.
4. Unlatch the used printhead by lifting the button in the center of the carriage.
5. Lift the used printhead out of the carriage.

6. Remove the new printhead from its bag.

⚠️ CAUTION:
Do not touch the copper contacts on the printhead, as doing so may damage the printhead.

7. Remove the two plastic protective caps.
8. Place the new printhead into the carriage.

9. Push firmly against the target label of the printhead until you hear a loud snap.

10. Insert the black ink cartridge into the printhead.
11. Press down on the ink cartridge until you hear it click into position.

![Image of ink cartridge being replaced]

12. Repeat steps 10 - 11 for the color ink cartridge.
13. Close the printer access door.
   The printer detects the new printhead. Follow the instructions on the LCD to calibrate your printer.

**Updating the software and printer firmware**

Using the latest software and firmware helps ensure optimal performance of your printer.

**NOTE:** Firmware is the software that runs on your printer.

When you open Home Center Software on a computer with WINDOWS OS, the software automatically checks for software and firmware updates. On a computer with MAC OS, you must check manually for updates.

Use the following procedure to update manually.

**Updating if your printer is connected to a computer with WINDOWS OS**

**To update the software:**

1. Make sure that your computer is connected to the Internet.
2. Open Home Center Software.
3. Click **Tools and Documentation**.
4. Under Web Links, click **Check for Software Updates** to check whether software updates are available.
5. If there are updates, click **Next** and follow the on-screen instructions.
To update the printer firmware:

1. Make sure that your computer is connected to the Internet.
2. Connect the printer to the computer with a USB cable or wirelessly (if not currently connected).
3. Open Home Center Software, and make sure that **KODAK ESP 5200 Series AiO - Connected** appears in the lower left corner of the Home Center Software window.
4. Click **Tools and Documentation**.
5. Under Web Links, click **Check for Printer (Firmware) Updates**.
6. If there are updates, click **Next** and follow the on-screen instructions.

**IMPORTANT:** *Do not turn off or unplug your printer or your computer during the update. Doing so may cause the printer to become inoperable.*

Updating if your printer is connected to a computer with MAC OS

To update the software:

1. Make sure that your computer is connected to the Internet.
2. Open Home Center Software.
3. On the KODAK AiO Home Center menu, select **Check for Updates**.
4. If there are software updates, follow the on-screen instructions for updating your software.

To update the firmware:

2. Connect the printer to the computer with a USB cable or wirelessly (if not currently connected).
3. Select your operating system from the drop-down list.
4. Click **Select** in the Firmware box.
5. Read the instructions, click **Download**, then follow the on-screen instructions.

**IMPORTANT:** *Do not turn off or unplug your printer or your computer during the update.*
Monitoring and adjusting printer performance

From the control panel, you can perform tasks to help keep the printer functioning well.

Checking ink levels

To check the ink levels:

1. Press Home.
2. Press ▼ to select Maintenance, then press OK.
3. With Check Ink Levels selected, press OK.
   The LCD shows approximate levels of ink in the cartridges so you know when it’s time to order replacement cartridges.

Resetting factory defaults

To reset defaults to the factory default settings:

1. Press Home.
2. Press ▼ to select Printer Settings.
3. Press ▼ to select Reset All Settings, then press OK.
4. When you see the message, “This will reset printer settings to factory defaults,” press OK.

NOTE: Resetting factory defaults does not change the date and time, language, country/region, or network settings.
## Basic troubleshooting

Some problems can be resolved quickly by power cycling the printer: Turn off your printer. Wait five seconds. Turn on the printer.

Use the following information to help troubleshoot problems with your printer.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer does not power on</td>
<td>• Make sure you are using the power cord that came with your printer.</td>
</tr>
<tr>
<td></td>
<td>• Make sure the power cord is connected to the AC adapter, it is plugged into an</td>
</tr>
<tr>
<td></td>
<td>outlet or power strip, and that the LED on the AC adapter is lit.</td>
</tr>
<tr>
<td>Printer not detected</td>
<td>• Make sure your printer is plugged in and turned on.</td>
</tr>
<tr>
<td></td>
<td>• If you are using a USB cable, make sure that:</td>
</tr>
<tr>
<td></td>
<td>– it is a USB 2.0 High-Speed cable.</td>
</tr>
<tr>
<td></td>
<td>– it is connected to both your printer and your computer.</td>
</tr>
<tr>
<td></td>
<td>– you restart the computer if the USB cable was disconnected from the printer</td>
</tr>
<tr>
<td></td>
<td>then reconnected, or if power to the printer was interrupted.</td>
</tr>
<tr>
<td></td>
<td>• If you are using a wireless connection, make sure:</td>
</tr>
<tr>
<td></td>
<td>– the Wi-Fi connectivity LED on the printer is glowing steadily.</td>
</tr>
<tr>
<td></td>
<td>– the printer is connected to your wireless network.</td>
</tr>
<tr>
<td></td>
<td>To check:</td>
</tr>
<tr>
<td></td>
<td>a. On the printer, press <strong>Home</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Press ▼ to select <strong>Network Settings</strong>, then press <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Press ▼ to select <strong>View Network Configuration</strong>, then press <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>Make sure that the Active Connection Type is WiFi, and that the IP Address is</td>
</tr>
<tr>
<td></td>
<td>not zeros.</td>
</tr>
<tr>
<td></td>
<td>– your router is transmitting data.</td>
</tr>
<tr>
<td></td>
<td>– the firewall (excluding WINDOWS Firewall) is allowing the services needed for</td>
</tr>
<tr>
<td></td>
<td>your printer.</td>
</tr>
<tr>
<td></td>
<td>For additional information, go to <a href="http://www.kodak.com/go/inkjetnetworking">www.kodak.com/go/inkjetnetworking</a>.</td>
</tr>
<tr>
<td>Carriage jam</td>
<td>• Open the printer access door and clear any obstructions.</td>
</tr>
<tr>
<td></td>
<td>• Check that the printhead and ink cartridges are installed correctly.</td>
</tr>
<tr>
<td></td>
<td>(The printhead and ink cartridges are installed correctly when you hear them click</td>
</tr>
<tr>
<td></td>
<td>into place.)</td>
</tr>
</tbody>
</table>
### Problem Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| Print quality                 | • For best results, use KODAK Paper or a paper with the COLORLOK Technology logo on the package.  
                                 | • Make sure the paper is loaded correctly. See Loading paper, page 14.             |
|                               | • Clean the printhead:                                                              |
|                               |   – Press **Home**.                                                                 |
|                               |   – Press ‹ to select **Maintenance**, then press **OK**.                           |
|                               |   – Press ‹ to select **Clean Printhead**, then press **OK**.                      |
|                               | • Calibrate the printer:                                                            |
|                               |   – Press **Home**.                                                                 |
|                               |   – Press ‹ to select **Maintenance**, then press **OK**.                           |
|                               |   – Press ‹ to select **Calibrate Printer**, then press **OK**.                    |
|                               | For more information, go to [www.kodak.com/go/esp5250support](http://www.kodak.com/go/esp5250support) or  |
|                               | [www.kodak.com/go/esp5210support](http://www.kodak.com/go/esp5210support), then type the problem in the search field. |
| Ink cartridge errors          | • Make sure that KODAK Ink Cartridge(s) are installed. Do not use non-Kodak brand or refilled ink cartridges. |
|                               | • Remove, then install the cartridges again. Make sure the cartridges click into place. |
| Paper jam                     | • Check for paper in the rear-access cleanout area.                                |
|                               | • Open the printer access door and gently remove any paper from inside the printer.|
|                               | • Make sure the paper in the tray is free of tears or creases.                    |
|                               | • Make sure you do not overload the paper tray.                                    |
|                               | For more information, go to [www.kodak.com/go/esp5250support](http://www.kodak.com/go/esp5250support) or  |
|                               | [www.kodak.com/go/esp5210support](http://www.kodak.com/go/esp5210support), then type **jam** in the search field. |
| Error codes/messages          | Go to [www.kodak.com/go/esp5250support](http://www.kodak.com/go/esp5250support) or  |
|                               | [www.kodak.com/go/esp5210support](http://www.kodak.com/go/esp5210support), then type your error code or message. |

### Getting help on the Web

For more troubleshooting information:

<table>
<thead>
<tr>
<th>Get help with wireless networking.</th>
<th><a href="http://www.kodak.com/go/inkjetnetworking">www.kodak.com/go/inkjetnetworking</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Search our knowledge base of Answers to Questions.</td>
<td><a href="http://www.kodak.com/go/esp5250support">www.kodak.com/go/esp5250support</a> or</td>
</tr>
<tr>
<td>Download the latest firmware and software for optimal printer performance.</td>
<td><a href="http://www.kodak.com/go/esp5250downloads">www.kodak.com/go/esp5250downloads</a> or</td>
</tr>
<tr>
<td>Check the Extended User Guide for detailed instructions and the recommended system requirements.</td>
<td><a href="http://www.kodak.com/go/aiomanuals">www.kodak.com/go/aiomanuals</a></td>
</tr>
</tbody>
</table>
**Troubleshooting**

Get help with problems you cannot resolve. Contact Kodak at [www.kodak.com/go/contact](http://www.kodak.com/go/contact) and have the following information available:

- Kodak Service Number (located inside the printer when you open the printer access door)
- Printer model number (located on the control panel)
- Computer model, operating system, and version of Home Center Software
- Exact wording of any error message(s) and the error code

---

### Status lights

The status lights indicate the condition of the printer. There are two status lights on the printer, one that indicates power, the other indicates Wi-Fi status.

#### Power status light

<table>
<thead>
<tr>
<th>Power light</th>
<th>What it means</th>
</tr>
</thead>
</table>
| Off         | • The printer is turned off.  
  • Press the on/off button to turn on power.  
  • The printer does not have power.  
  • Make sure that the power cord is plugged into the back of the printer and into an electrical outlet, and that the electrical outlet has power. |
| Blinking    | • The printer is busy.  
  • Wait for the printer to finish the task. |
| On          | • The printer is ready |

#### Wi-Fi status light

<table>
<thead>
<tr>
<th>Power light</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The Wi-Fi radio is either turned off, or is turned on but not connected to a wireless network.</td>
</tr>
<tr>
<td>Blinks continuously</td>
<td>The Wi-Fi radio is turned on and the printer is searching for available wireless networks within range.</td>
</tr>
<tr>
<td>Power light</td>
<td>What it means</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Blinks intermittently</td>
<td>The Wi-Fi radio is turned on and the printer cannot find any available wireless networks within range, or the Wi-Fi radio connection has been interrupted, or is too weak to send signals to and from the printer. To find and connect to an available wireless network within range, press <strong>OK</strong>, turn the Wi-Fi radio off, and run the WiFi Setup Wizard (see Connecting to a wireless network, page 5).</td>
</tr>
<tr>
<td>On</td>
<td>The Wi-Fi radio is turned on and there is a working connection between the printer and a wireless network.</td>
</tr>
</tbody>
</table>
9 Product and Safety Specifications

The following specifications are subject to change without notice.

Specifications and features

Print performance

- **Black print speed**: Up to 30 pages per minute on plain paper
- **Color print speed**: Up to 29 pages per minute on plain paper
- **Print technology**: Continuous-tone, thermal inkjet
- **Print quality modes**: Draft, Normal, and Best on plain paper
  Photo quality mode on photo paper

Photo printing features

- **Quantity**: 1 to 99 (may vary for different models of the 5200 series printers)
- **Print sizes**:
  - 2 x 3 in. (5 x 7.6 cm)
  - 3.5 x 5 in. (9 x 12.7 cm)
  - 4 x 6 in. (10 x 15 cm)
  - 4 x 7 in. (10 x 18 cm)
  - (Panoramic) 4 x 12 in. (10 x 30 cm)
  - 5 x 7 in. (13 x 18 cm)
  - 8 x 10 in. (20 x 25 cm)
  - US Letter - 8.5 x 11 in. (22 x 28 cm)
  - A4 (21 x 30 cm)
- **Quality**: Best, Normal, Draft
- **Auto-detect media**: Auto-detect plain paper, photo paper, and transparency
  Optimize image quality for KODAK Photo Papers with barcode
- **Image enhancement**: KODAK PERFECT TOUCH Technology with Home Center Software
- **Add date to prints**: No (default), Yes
- **Color**: Black-and-white or color
- **Scene balance**: On (default), Off

Copy document features

- **Color**: Black-and-white or color
- **Quantity**: 1 to 99 copies
  (may vary for different models of the 5200 series printers)
- **Copy sizes**:
  Same Size, Fit-to-Page, 20% to 500%
  (may vary for different models of the 5200 series printers)
- **Plain paper quality**: Best, Normal, Draft
- **Brightness**: – 3 to + 3
Copy photo features

**Color**  Black-and-white or color

**Quantity**  1 to 99 copies  
(may vary for different models of the 5200 series printers)

**Copy sizes**  
2 x 3 in. (5 x 7.6 cm)  
3.5 x 5 in. (9 x 12.7 cm)  
4 x 6 in. (10 x 15 cm)  
4 x 7 in. (10 x 18 cm)  
(Panoramic) 4 x 12 in. (10 x 30 cm)  
5 x 7 in. (13 x 18 cm)  
8 x 10 in. (20 x 25 cm)  
US Letter - 8.5 x 11 in. (22 x 28 cm)  
A4 (21 x 30 cm)

**Quality**  Automatic

**Brightness**  -3 to +3

Scanning features

**Scanner type**  Contact Image Sensor (CIS)

**Maximum scan size**  8.5 x 11.7 in. (21.6 x 29.7 cm)

**Functions**  Segmentation scanning  
Auto-destination  
OCR  
Auto picture detection

Paper tray features

**Paper capacity**  
100 sheets of 20 lb plain paper  
20 sheets of photo paper, up to 12 mil (290 gsm)  
20 envelopes

**Tray size**  4 x 6 in. to 8.5 x 14 in. (10 x 15 cm to 21.6 x 36 cm)

Ink cartridges

**Ink handling**  2-cartridge, 6-ink system

**Ink life**  1-year warranty from date of purchase
Connectivity

**Protocols supported**  USB 2.0 High Speed; DPOF, MIPC

**Devices supported**  WINDOWS OS-based and MACINTOSH Computers, memory cards (SD, MS/Duo, MMC, SDHC)

**Image Formats supported**  Image printing supports JPEG (EXIF v2.2); does not support progressive JPEG format

**Number of USB ports**  One rear device port (high speed)

**Protocols supported**  USB 2.0 High Speed (for connection to computer only), DPOF (Tagged image printing), MIPC

**Wi-Fi Technology supported**  802.11b/g/n, WPA/WPA2, and WPS

Software support

**Application support**  Third-party image management applications; optical character reader (OCR) support for documents

**Media support**  Plain paper, photo paper, envelopes, greeting cards, transparencies with white stripe, labels

**Scanner support**  TWAIN and WIA, WIA2 (VISTA OS and WINDOWS 7), ICA (MAC OS), including segmentation scanning

**Update support**  Software and firmware updates available through Web support

Physical specifications

**Power**  WW: 110-240 V AC, 50-60 Hz at 1.3 A

Output: 36 V DC at 1.6 A

**Dimensions**  422 x 98 x 181 mm [L × H x D]

(16.6. x 11.7. x 7.1 in.)

**Weight**  5.7 kg (12.7 lb)

**Operating range**  5°C (41°F) to 35°C (95°F), 15 to 85% RH

**Full image quality environmental range**  15°C (59°F) to 30°C (86°F), and 20 to 80% RH.

**Energy efficiency**  ENERGY STAR® Qualified All-in-One Printer

Warranty

**Printer**  One year from purchase (with proof of purchase)

**Printhead**  One year from purchase (with proof of purchase)
System requirements

Computer with WINDOWS OS

Minimum

**Operating system**  WINDOWS 7, VISTA, or XP (SP2 or later)
**CPU**  INTEL CELERON Processor
**Clock speed**  1.2 GHz
**Memory**  512 MB RAM
**Available hard disk space**  500 MB available
**Interface**  USB 2.0 High Speed
**Removable drive**  CD-ROM

Computer with MAC OS

Minimum

**Operating system**  MAC OS X 10.4.8 or later
**CPU**  PowerPC G4, G5, or INTEL-based Mac
**Clock speed**  1.2 GHz
**Memory**  512 MB RAM
**Available hard disk space**  200 MB available
**Interface**  USB 2.0 High Speed
**Removable drive**  CD-ROM

Paper types supported

- **Plain paper**  20 to 24 lb (75 to 90 gsm)
- **Photo paper**  Up to 12 mil (290 gsm)
- **Card stock**  110 lb index max (200 gsm)
- **Envelopes**  20 to 24 lb (75 to 90 gsm)
- **Transparencies**  All commercially available inkjet varieties (with a white stripe)
- **Labels**  All commercially available inkjet varieties on 8.5 x 11 in. and A4 size sheets
- **Iron-on transfers**  All commercially available inkjet varieties on 8.5 x 11 in. and A4 size sheets
## Paper sizes supported

**Plain paper**  
A4 (8.3 x 11.7 in. / 21 x 30 cm)  
A5 (5.8 x 8.3 in. / 15 x 21 cm)  
A6 (4.1 x 5.8 in. / 11 x 15 cm)  
B5 (6.9 x 9.8 in. / 18 x 25 cm)  
US Executive (7.3 x 10.5 in. / 18 x 27 cm)  
US Letter (8.5 x 11 in. / 22 x 28 cm)  
US Legal (8.5 x 14 in. / 22 x 36 cm)  
Custom sizes from 4-8.5 in. / 10-22 cm wide and 6-14 in. / 15-36 cm long

**Labels**  
A4 (8.3 x 11.7 in. / 21 x 30 cm)  
US Letter (8.5 x 11 in. / 22 x 28 cm)

**Index card stock**  
4 x 6 in. index cards (10 x 15 cm)  
5 x 7 in. index cards (13 x 18 cm)

**Transparencies and iron-on transfers**  
A4 (210 x 297 mm)  
US Letter (8.5 x 11 in.) (216 x 280 mm)

**Envelopes**  
C5 (6.7 x 9 in. / 16 x 23 cm)  
C6 (4.5 x 6.4 in. / 11 x 16 cm)  
DL (designated long) (4.3 x 8.7 in. / 11 x 22 cm)  
US #7¼ (3.9 x 7.5 in. / 10 x 19 cm)  
US #9 (3.9 x 8.9 in. / 10 x 23 cm)  
US #10 (4.12 x 9.5 in) (105 x 241 mm)

**Photos**  
4 x 6 in. (10 x 15 cm)  
4 x 7 in. (10 x 18 cm)  
4 x 12 in. (10 x 31 cm)  
5 x 7 in. (13 x 18 cm)  
8 x 10 in. (20 x 25 cm)  
US Letter (8.5 x 11 in. / 22 x 28 cm)  
A4 (8.3 x 11.7 in. / 21 x 30 cm)
Safety information

KODAK ESP 5200 Series All-in-One Printers are Class 1 LED Products.

- Always follow all warnings and instructions marked on the product.
- Use only the power source indicated on the product regulatory label.
- Use only the power cord that comes with the product (or an approved power cord greater or equal to H05W-F, 2G, 0.75mm²). Using another power cord may cause fire and/or shock. Do not use the included power cord with any other equipment.
- If you do not use this product for a long period of time, unplug it from the electrical outlet.
- Always turn this product off by using the On/Off button. Wait until the On/Off button stops flashing before removing the power plug from the outlet.
- Do not allow the power cord to become damaged or frayed.
- If you need to use an extension cord with this product, make sure that the ampere rating of the product does not exceed the ampere rating of the extension cord.
- Place the product on a flat, stable surface that extends beyond the product’s base in all directions. This product will not operate properly if tilted or at an angle.
- When storing or transporting this product, do not tilt or stand it on its side. Never turn this product upside down (ink can leak out of the product).
- Avoid placing this product in an environment that is subject to rapid changes in temperature or humidity, mechanical shocks, vibration, or dust. Do not place near radiators, heating vents, or in direct sunlight.
- Leave enough room around this product for sufficient ventilation.
- Do not block this product’s covers or openings, or insert any objects through slots.
- Do not use aerosol products inside or around this product.
- Do not spill any liquid on this product.
- Do not attempt to repair or service this product.
- If the power cord or plug is damaged, if any liquid has been spilled onto the product, if the product has been dropped or the case damaged, if the product does not operate normally or exhibits a major change in performance level, unplug this product and contact Kodak at www.kodak.com/go/contact.

For Service Personnel:

⚠️ CAUTION: 
Risk of explosion if battery is replaced by an incorrect type. Dispose of used batteries according to local instructions.
**Product and Safety Specifications**

**LCD screen safety**
- Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or chemical cleaners.
- If the LCD screen is damaged, contact Kodak immediately. If any of the solution from the display gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush your eyes immediately with water. If any discomfort or change in vision persists after washing, seek medical attention immediately.

**Ink cartridge safety**
- Keep all ink cartridges out of the reach of children.
- If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush immediately with water. If any discomfort or change in vision persists after washing, seek medical attention immediately.
- For MSDS information on inks, go to [www.kodak.com/go/MSDS](http://www.kodak.com/go/MSDS).

**Regulatory compliance**

**FCC statement**

The United States Federal Communications Commission (in CFR 47 Part 15.105) has specified that the following notice be brought to the attention of the users of this product:

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the product into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
CAUTION:
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this product not expressly approved by Eastman Kodak Company might cause harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency exposure limits. Nevertheless, the product shall be used in such a manner that the potential for human contact during normal operation is minimized. This product and any attached external antenna, if supported, shall be placed in such a manner to minimize the potential for human contact during normal operation. In order to avoid the possibility of exceeding the FCC exposure limits, human proximity shall not be less than 20 cm (8 inches) during normal operation.

Canadian statements
This product meets the applicable Industry Canada technical specifications. Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

Industry Canada (IC) Radiation Exposure Statement
This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 cm between the radiator and your person.

European compliance statement
Hereby, Eastman Kodak Company declares that this KODAK all-in-one wireless printer is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.

German compliance statement
CAUTION:
This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.
CAUTION:
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Noise emissions for this equipment do not exceed 70 dBA.

This equipment is not intended for use in the work place in accordance with BildscharbV regulations.

“Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß BildscharbV vorgesehen.”

REACH Article 33 declarations
Go to www.kodak.com/go/REACH for information about the presence of substances included on the candidate list according to article 59(1) of Regulation (EC) No. 1907/2006 (REACH).

Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. Contact your local authorities or go to www.kodak.com/go/recycle for recycling program information.

ENERGY STAR® Qualified All-in-One Printer

To conserve energy, this printer will enter a reduced power (sleep) mode automatically after 1 hour. You can adjust the delay time (in 0.5 hour increments) up to 4 hours. Increasing the delay time may result in reduced energy savings.

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an ENERGY STAR partner, KODAK has determined that this product meets ENERGY STAR Guidelines for energy efficiency. For more information on the ENERGY STAR program, see www.energystar.gov.
**Warranty Information**

**Limited Warranty**

Kodak warrants Kodak consumer electronic products and accessories ("Products"), excluding batteries, to be free from malfunctions and defects in both materials and workmanship for one year from the date of purchase. Retain the original dated sales receipt. Proof of the date of purchase will be required with any request for warranty repair.

**Limited Warranty Coverage**

Warranty service is only available from within the country where the Products were originally purchased. You may be required to send Products, at your expense, to the authorized service facility for the country where the Products were purchased. Kodak will repair or replace Products if they fail to function properly during the warranty period, subject to any conditions and/or limitations stated herein. Warranty service will include all labor as well as any necessary adjustments and/or replacement parts. If Kodak is unable to repair or replace a Product, Kodak will, at its option, refund the purchase price paid for the Product provided the Product has been returned to Kodak together with proof of the purchase price paid. Repair, replacement, or refund of the purchase price are the sole remedies under this warranty. If replacement parts are used in making repairs, those parts may be remanufactured or may contain remanufactured materials. If it is necessary to replace the entire Product, it may be replaced with a remanufactured Product. Remanufactured Products, parts and materials are warranted for the remaining warranty term of the original Product, or 90 days after the date of repair or replacement, whichever is longer.

**Limitations**

This warranty does not cover circumstances beyond Kodak's control. This warranty does not apply when failure is due to shipping damage, accident, alteration, modification, unauthorized service, misuse, abuse, use with incompatible accessories or attachments (such as third party ink or ink tanks), failure to follow Kodak's operation, maintenance or repacking instructions, failure to use items supplied by Kodak (such as adapters and cables), or claims made after the duration of this warranty. KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. In the event that the exclusion of any implied warranty is ineffective under the law, the duration of the implied warranty will be one year from the purchase date or such longer period as required by law. The option of repair, replacement, or refund is Kodak's only obligation. Kodak will not be responsible for any special, consequential or incidental damages resulting from the sale, purchase, or use of this product regardless of the cause. Liability for any special consequential or incidental damages (including but not limited to loss of revenue or profit, downtime costs, loss of the use of the equipment, cost of substitute equipment, facilities or services or claims of your customers for such damages resulting from the purchase, use or failure of the Product), regardless of cause, or for breach of any written or implied warranty is expressly disclaimed.

**Your Rights**

Some states or jurisdictions do not allow exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you. Some states or jurisdictions do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you. This warranty gives you specific rights, and you may have other rights which vary from state to state or by jurisdiction. Your statutory rights are not affected.

**Outside the United States and Canada**

In countries other than the United States and Canada, the terms and conditions of this warranty may be different. Unless a specific Kodak warranty is communicated to the purchaser in writing by a Kodak company, no warranty or liability exists beyond any minimum requirements imposed by law, even though defect, damage, or loss may be by negligence or other act.
Declaration of Conformity

See www.kodak.com/go/declarationofconformity.
Index

A
access door, 1

B
back button, 2

C
cancel button, 2
cleaning
document backing, 40
printer, 39
scanner glass, 40
cleanout area, rear access, 1
components, printer, 1
computer requirements, 57
configuring printer settings, 3
connecting to a wireless network, 5—10
  additional printer, 10
  from USB, 11—12
  printer on additional computers, 10
control panel
  features and descriptions, 2
  location, 1
copy document features, 54
copy photo features, 55
copying, 24—33
documents, 24—28
  adjusting settings, 25—26
  changing number of copies, 26
copy sizes, 54
darkening, 28
enlarging, 27
lightening, 28
reducing, 27
using default settings, 24
photos, 29—33
  adjusting settings, 30—31
  changing number of copies, 31
copy sizes, 55
darkening, 33
enlarging, 32
lightening, 33
previewing on LCD, 31
reducing, 32
using default settings, 29
setting options, 25—26, 30—??, 30—31
country/region, setting, 4
cropping pictures. See zooming and cropping pictures

D
darkening copies
documents, 28
photos, 33
date and time
  setting, 3
  synchronizing to computer, 3
document backing, cleaning, 40
default printer, setting, 4
defaults
  resetting, 4, 49
  save copy settings as
documents, 26
  photos, 31
  save scan settings as, 38
document backing, cleaning, 40
document paper sizes, 58
documents
  copying, 24—28
  printing, 17
  printing from wireless device, 23
  printing two-sided, 17—18
downloading (updating)
  printer firmware, 47
  software, 47
DPOF (digital print order format) printing, 3
duplexing, 17—18

E
EASYSHARE Software, 18
Energy Star qualification, 62
enlarging copies
documents, 27
photos, 32
envelopes
  loading, 16
  sizes, 14, 58

F
firmware, downloading (updating), 47

G
glass, scanner, cleaning, 40

H
home button, 2
Home Center Software, 3
hostname, printer, 9
I
Image Capture software, 23
image formats supported, 56
index card stock sizes, 58
ink cartridges, replacing, 41—43
ink levels, 49
IP address
setting up, 8
viewing, 9
iPhoto software, 23
iron-on transfers, 58
K
keyboard on LCD, using, 8
KODAK EASYSHARE Software, 18
KODAK Home Center Software, 3
KODAK Pic Flick App, 23
L
label sizes, 58
language, setting, 4
LCD, 1, 2
left paper-edge guide, location, 1
lightening copies
documents, 28
photos, 33
lights
power status, 52
Wi-Fi status, 52
loading paper in tray
envelopes, 16
photo, 15
plain paper, 14
M
MAC address, viewing, 9
marked images, printing. See tagged images
media supported, 57
memory card slot, 1
memory cards
types compatible with printer, 18
N
navigation buttons, 2
network, wireless
configuration, viewing and printing, 9
connecting to, 5—10
non-WPS router, 5
WPS router, 7
installing printer on, 10
IP address, setting up, 8
subnet, viewing, 9
O
OK button, 2
on/off button, 2
overview of printer, 1
P
paper, 13
loading in tray
envelopes, 16
photo paper, 15
plain paper, 14
sizes supported, 13, 58
types supported, 13, 57
paper tray
capacity, 55
envelopes, 16
photo paper, 15
plain paper, 14
extender, location, 1
location, 1
photo paper
capacity, 15
loading, 15
sizes supported, 58
photo printing
features, 54
adding date to prints, 54
image enhancement, 54
print sizes, 54
scene balance, 54
from wireless device, 23
Pic Flick App, 23
plain paper
capacity, 14
loading, 14
power cord connection port, 1
power status light, 52
printer
access door, 1
cleaning instructions, 39
defaults, resetting, 4, 49
hostname, 9
maintaining, 39—49
settings, configuring, 3
supplies
ordering using Home Center Software, 3
recycling, 39
printer connection, changing
USB to wireless, 11
printhead
location, 1
removing, 45
replacing, 44—47
printing, 17—23
  documents, 17
  tagged image photos, 21
  tagged pictures, 3
  two-sided documents, 17—18

R
  rear-access cleanout area, 1
  recycling printer or supplies, 39
  red box around image on LCD, 22
  reducing copies
    documents, 27
    photos, 32
  regulatory compliance
    European, 61
  removing the printhead, 45
  replacing ink cartridges, 41—43
  resolution, scanning, 35
  right paper-edge guide, 1
  rotate button, 2, 22

S
  scanner glass
    cleaning, 40
    location, 1
  scanner lid, 1
  scanner type, 55
  scanning, 34—38
    automatically detect pictures, 36
    changing settings in Home Center Software, 34
    features, 55
    file format
      document, 34
      picture, 35
    from computer, 36—37
    from control panel, 37
    maximum scan size, 55
    multiple pictures simultaneously, 36
    resolution, 35
    selecting quality, 35
    setting options, 19—21, 38
  settings
    copy documents, 25—26
    copy photos, 30—31
    copying, 25—26, 30—31
    scanning, 19—21, 38
  software
    downloading (updating), 47
    Home Center, 3
    support, 56
  specifications, 54—58
  start button, 2
  supplies
    ordering, using Home Center Software, 3
    recycling, 39
    system requirements, 57

T
  tagged images, printing, 21
  time to low power, setting, 3
  time, setting, 3
  transferring pictures to a computer, 23
  transparency sizes, 58
  tray, paper, capacity
    envelopes, 16
    photo paper, 15
    plain paper, 14
  troubleshooting, 50—52
    help on the web, 51
  two-sided printing, 17—18

U
  USB connection, changing to wireless, 11—12
  USB port location, 1

W
  warranty, 55
  Web support
    contact information, 52
    downloads, 51
    Electronics Industry Alliance, 39
    firmware update, 48
    iPhone software, 23
    iPod Touch Device software, 23
    networking, 11, 50, 51
    Pic Flick App, 23
    printer support
      ESP 5210, 51
      ESP 5250, 19, 25, 30, 51
    recycling, 39
    system requirements, 51
  WEP key, 6
  Wi-Fi
    status light, 52
    technology supported, 56
  WiFi
    connectivity LED, 1
    Setup wizard, 5
  wireless device, printing from, 23
wireless network
  configuration, viewing and printing, 9
  connecting to, 5—10
    additional KODAK All-in-One Printer(s), 10
    from USB, 11
    non-WPS router, 5
    printer on additional computers, 10
    using WiFi Setup wizard, 5
    WPS router, 7
  IP address, setting up, 8
  settings, configuring, 5
WPA/WPA2 passphrase, 6
WPS router, 7

Z
  zoom buttons, 2
  zooming and cropping pictures, 22